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Introduction 

Standard Telephone Features 

The Cypress Communications Bria softphone has standard telephone features, including: 

•  Call display and Message Waiting Indicator (MWI). 

•  Speakerphone and Mute. 

•  Redial, Hold, Do Not Disturb 

•  Call history – list of received, missed, and dialed calls. 

•  Call forward. 

•  Call transfer. 

•  Call record. 

•  Six-party audio conferencing. 

Enhanced Features and Functions 

The Bria also supports the following features and functions: 

•  Managed contact list – importing and exporting contacts between Bria and other applications. 

•  Automatic detection and configuration of audio and video devices. 

•  Acoustic echo cancellation, automatic gain control, voice activity detection. 

•  Support for the following audio codecs: 

•  Automatic selection of the best codec based on the other party’s capability, the available 
bandwidth, and network conditions. Bria switches the codec within a call in response to changing 
network conditions. 

•  SIP compliance to 3261 SIP standard. 

•  STUN and ICE NAT traversal. 

•  Support for DTMF (RFC 2833, inband DTMF or SIP INFO messages).  

•  Availability in other languages. 
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Installation and Setup 

Getting Ready 

Multimedia Device Requirements 

Bria requires both speakers and a microphone to make calls. Any of the following configurations are 
acceptable: 

•  External speakers and microphone 

•  Built-in speakers and microphone 

•  Dual-jack multimedia headset 

•  Bluetooth® multimedia headset 

•  USB multimedia headset 

•  USB phone.  

Optimized Devices 

Bria is optimized to work with the following: 

•  Actiontec Internet Phone Wizard 

•  GN Netcom GN 8120 USB and GN Netcom 8110 USBXP 

•  Plantronics CS50-USB Wireless Office Headset System 

•  Polycom® Communicator C100S Wideband USB Speakerphone 

•  TigerJet RJ11 to USB Phone Adaptor (incorporating the Tiger560C) 

•  TigerJet USB Phone Set (incorporating the Tiger560C) 

•  Yealink USB-P1K USB hand phone 
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Using Bria 

Starting Bria 

If Bria is not already running, start it as you would any other program: Use the Windows Start menu 
(Start > Programs > Cypress Communications > Bria) or double-click the desktop icon. Bria appears. 

 

Shutting Down 

To shut down Bria, click File > Exit, or press Ctrl+Q. Note that clicking the Close button (X) on the 
softphone minimizes Bria to the system tray; it does not exit. 

The Onscreen Softphone  

 

The Bria Menu 

File 

•  Preferences - These settings control the way that you work with Bria and apply to all accounts. 

•  Account Settings - You will work with these settings only if advised to do so by your system 
administrator. See “Configuring Bria”. 

•  Exit - To shut down Bria. You can also exit by pressing Ctrl+Q. 
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View 

Change how Bria looks. 

Contacts 

Lets you work with contacts. Everything in this menu except for import and export can also be 
performed directly in the Address Book panel.  

Actions 

Lists the actions that you can perform, depending on the current “state” of Bria. For example, if a 
contact is selected, it lists all the actions that can be performed on that contact. 

If your enterprise has configured Bria to display a Workgroup, you can view the Workgroup from the 
Actions menu. 

Help 

Provides access to various service-related features.  

Showing and Hiding Parts of the Softphone 

 

You can still receive calls when Bria is hidden or minimized. 

Show/Hide Dialpad Display as Deskbar 

Close to System Tray 

Close Call Panel (only Call entry 
field will remain). Click again to 
open. 

Move Address Book to separate 
window 

Show/Hide Address Book 

Drag to Resize 
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If you exit when Bria is minimized or in Deskbar mode; Bria will start next time as minimized or in 
Deskbar mode. 

The Deskbar 

To display the softphone as a deskbar, click the Deskbar button. 

 

The Deskbar provides a compact GUI for performing many Bria actions. It is assumed that you will work 
in this mode after you are quite familiar with Bria and its features. 

 

 

Placing a Call 

You can contact someone using: 

•  A softphone address (for example, kpereira@domainA.com) 

•  A traditional phone number. 

You can place a call when another call is already in progress. There is no limit to the number of calls you 
can make, although eventually the quality of audio and video will degrade because of limitations on the 
computer. We recommend no more than six concurrent calls. 

Deskbar button 

Missed Calls Entry field 
Call/End Call 

button More Options button 

Restore to main window 
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1. Place the call. See the table below.  

The new call is added to the Current Calls bar. You will hear a ringing tone while Bria attempts to 
make a connection. 

2. Once the new call is established, switch between different calls by clicking the tab in the Current 
Calls bar. 

  

Redial 

Call Entry field 

Call toolbar 

Current Calls bar 

Other calls are on hold 

Filter 

Click button to place call 
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How From the... Description 

Keying Dialpad or computer 
keyboard 

1.  If another call is currently in progress, click  on the Call 
toolbar. A new Call Entry area appears. The current call is 
put on hold. 

2.  Enter the softphone address or number in the Call entry 
field using the dialpad or the computer keyboard. 

For the name, you can enter the entire softphone address 
(kpereira@domainA.com) or just the name (kpereira). 

As you type, a suggestion for completing the entry may 
appear. Choose the suggestion or keep typing. 

3.  To make an audio call, click the green Call button or press 
Enter. 

Drag-and-drop contact 
or previous call 

Contacts or History tab in 
the Address Book panel 

Drag an entry from the Contacts or History tab. The call is 
placed immediately. (If the tab contains lots of contacts, first 

use the  field to filter the list.) 

Right-click a contact or 
previous call 

Contacts or History tab in 
the Address Book panel 

Right-click an entry from the Contacts or History tab and 
choose Call. The call is placed immediately.  

(If the tab contains lots of entries, first use the  field to 
filter the list.) 

Double-click a contact Contacts in the Address 
Book panel 

Contacts have a “double-click” action that either makes phone 
call to a specific number. Each contact can be configured 
separately for this action. 

Double-click a 
previous call 

History tab in the Address 
Book panel 

Double-click an entry. The call is placed. 

Redial Redial button Click Options and choose Redial. Or click the Redial button.  

The call is placed immediately. 

Dialing Dialpad 1.  If the dialpad is not visible, click the Show/Hide dialpad 
button. 

2.  Click the numbers on the dialpad to enter the phone 
number. 

3.  Click the green Call button or press Enter. 
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Placing another Call 

To place a new call (without hanging up on the current call), click the Start another Call button. In the 
Current Calls bar, a tab appears for each separate call. 

 

Encryption 

The outgoing call may be encrypted, depending on your security settings.  

•  If an encrypted call is established, the encryption icon ( ) appears on the call display. This icon 
indicates that the call is guaranteed to be secure between you and your proxy, and may or may not 
be secure beyond that first hop.  

•  If an unencrypted call is established, no encryption icon appears. 

•  If the call cannot be established with the specified security, the call will fail. 

Ending a Call 

Click the red End call button on the Call panel. Details of the call remain on the call display for a few 
seconds. 

Handling an Incoming Call 

Bria must be running to answer incoming calls. 

Bria rings and information about the incoming call appears in the Call entry field. In addition, the Call 
Alert box appears, even if Bria is minimized. 

 

The softphone address/number of the person calling you is displayed. The display name may also 
appear.  

 

 

 

Start another Call button 
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Action From the... Description 

Answer Call panel or Call Alert 
box 

Click Answer. 

If you are on another call, that first call is automatically put on hold. 
You are now talking to the new caller. 

Or press Enter (on the keyboard), if Bria is the active application. 

Decline Call panel or Call Alert 
box 

Click Decline. The call will be directed to voicemail (if you have this 
service). 

Permanently 
block the caller 

Options menu Click the Options button and choose Block this person. 

 

Auto Answer 

To turn auto answer off and on, in the Call panel click Options > Auto Answer. The AA icon appears in 
the call display. 

 

Auto answer is initially configured to auto-answer after one ring, and to send only your audio when the 
call is established. You can change this configuration. 

Auto answer is automatically turned off when you shut down or log off. 

Handling an Established Call 

While the call is in progress you can: 

•  Control the audio: use the speakerphone, mute the call, control volume. 

•  Record the call. 

•  Put the call on hold. 

•  Add the caller as a contact. 

•  Transfer the call. See the next page. 
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Transfering a Call 

Quick Transfer 

You can set up a list of phone numbers that calls can be transferred to. Then during a call, you can 
transfer to any of these numbers by selecting from a list. 

To set up the numbers: 

1.  Click File > Preferences from the menu. Display the Transfer panel. 

2. Enter as many numbers as you want. To enter a new number, click in an empty line. To remove an 
entry, click in the line and delete the number. 

Set one of the numbers as the default and click OK. 

To transfer a call, click the arrow on the Transfer button and click the number to transfer to. As soon as 
the transfer is made (the other phone starts ringing), the call is disconnected at your end.  

Add the current 
caller as a contact 

Conference call 

Hold 

Place 
another 

call 

Quick 
Transfer 

Mute 

Record 

Speakerphone (only appears 
if your computer has a 

speakerphone) 

Volume control 

Options that can 
be performed 

while a call is in 
progress 
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Basic (Unattended) Transfer – Transfer this Call 

You can transfer a call to any number, then hang up as soon as you have entered the number.  

1.  Click Options > Transfer this Call. The call display prompts for the number to transfer to. 

2. Call the target (the person you are transferring the call to) by keying the number. 

3. Click Transfer; the message Transfer Successful appears. 

Or click Cancel to continue the current call. 

 

Attended Transfer – Call then Transfer 

You can first speak to the target (the person you are transferring the call to), then click Transfer to 
complete the transfer. 

1.  Click Options > Call then Transfer. The first call is put on hold and a New call tab appears 

2. Call the target in any of the normal ways. 

3. When you are ready, click Transfer; the message Transfer Successful appears. 

Quick 
Transfer 
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If the target does not want to take the call, simply end the call with that person. The first call is taken off 
hold. 

 

Voicemail 

When you have voicemail messages, the word “new” appears beside the voicemail icon at the top of the 
phone. Click the icon to automatically connect to voicemail and listen to your messages. 

 

Conference Calls 

Starting a Conference Call 

You can create a conference call starting from one existing call: 

1.  Click the Conference icon. Bria enters “conference mode” and “Call a conference participant” 
appears on the call display. 

2. Place the second call in one of these ways: 

•  Right-click on a contact and choose Add to Conference Call. 

•  Type a name or number.  

(Or to cancel the call, click the Cancel button.) 

When the second callee answers, the call will automatically be added to the conference. 

Or you can start a conference call using all the existing, separate calls: 

1.  Establish the calls. The calls can be incoming or outgoing, and one or more calls can include video. 

Voicemail icon 
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2. Click Conference All. 

 

 

Managing the Conference 

Adding More Participants 

You can add more participants to an existing conference in any of these ways: 

•  Right-click on a contact and choose Add to Conference Call. 

•  From the tab that contains the conference, click the Conference icon. Place a call by typing a name 
or number. When the callee answers, the call will automatically be added to the conference. 

•  Place a separate outgoing call in the normal way (by clicking the New Call icon to display a new tab). 
When the call is established, click Conference All. All existing separate calls will be brought into the 
existing conference. 

•  Accept one or more incoming calls. A separate call will be established for each call. Click Conference 
All. All existing separate calls will be brought into the existing conference. 

Whenever you click Conference All, all current established calls are conferenced together; you 
cannot keep any one call out of the conference. 

Conference icon Enter number for new participant 

Conference is 
now established 

Click for actions for 
this participant 



Bria User Guide 

19 

Removing a Participant 

To remove one call from the conference, click the down arrow beside a participant name and choose 
Separate Call from Conference. The call becomes a separate call. 

Disbanding the Conference 

To break the conference into separate calls, click Options > Disband Conference. 

To hang up on everyone, click the End button. 

Suspending the Conference 

To suspend the conference, click the Hold button.  

Audio Controls 

Adjusting Volume 

Use the speaker adjustment to adjust volume of the sound you are hearing.  

Mute 

Click  on the dialpad to prevent the other parties from hearing you. The  icon appears on the 
call display. When you mute during a video call, you may also want to click Stop my Video to stop the 
video feed. 

Speakerphone 

Click  on the dialpad to put the callers on the speaker phone. The  icon appears on the call 
display. 

E-mail 

You can send an e-mail to one or more contacts, or to all the contacts in a group. The contacts must 
have e-mail addresses included in their Contact Profiles. 

Select the contact, contacts or group, right-click and choose Send E-mail. A new e-mail message opens in 
your default e-mail application. The new message includes the e-mail address(es) for the selected 
contacts in the “to” line. 

  



Cypress Communications  

20 

Using the Address Book 

The Address Book panel, which is divided into tabs, provides access to the following:  

•  Contacts. 

•  Call history. 

Contacts Tab 

 

The Contacts tab displays your contacts and lets you specify multiple contact methods for them, 
including: 

•  Softphone address  

•  Home phone number, business phone number, mobile phone number 

•  Fax number (this is provided for convenience; Bria does not have any fax capability). 

•  E-mail 

You can identify one of these contacts as the primary contact method.  

Contacts are typically organized into groups. Bria includes built-in groups: “Friends”, “Home” and 
“Work”. You can add more groups, as desired. 

Setting up Contacts 

Adding a Contact 

Click , or right-click a group and choose Add Contact to Group. The Contact Profile dialog box 
appears. 

Add a Contact Search field 

Select more 
display options 
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Table 1: Contact Profile Fields 

Field Description 

Contact name Only the “Display as” name is required. This is the name that will appear in the call display 
and the Call Alert when this person phones you. 

Group Either: 

•  Choose one group. 

•  Click Select Multiple Groups to add the new contact to more than one group. 

Ring tone Choose a ring tone for this contact, or use the preferred sound (which is defined in 
Preferences > Alerts). Click the arrow to play the currently selected ring tone. 

Contact Methods Enter as many contact methods as you want. E-mail and softphone entries must have the 
format <name>@<domain> 

Advanced The Advanced dialog appears, showing all the addresses for the contact. See below. 
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Double-click action Choose the desired method. This method will be used when you double-click this contact.  

For example, if you choose “IM:kpereira@domainA.com”, then double-clicking this contact 
will open an IM window using this address (rather than any of the other addresses that exist 
for this contact). 

Other fields Complete as desired. 

 

Adding a Contact using an Existing Address 

You can add a contact by capturing existing information: 

•  If you are on a phone call with a person who is not a contact, click the Add to Contacts button in the 
call panel. 

•  On the History tab, select an entry that is not a contact. Right-click and choose Add as Contact. 

The Add a Contact dialog appears.  

If the user portion of the address matches the user portion of an existing address, the Update option is 
automatically selected. For example, if the address is kpereira@domainB.com and there is an existing 
contact with an address of kpereira@domainA.com. Otherwise, the Create option is automatically 
selected. 

Take the appropriate action: 

•  Create a new contact: Click Create. Change the display name, contact method, and group if desired. 
Click OK. 

•  Update an existing contact. Click Update. Choose a different contact, if necessary. Change the 
contact method and group, if desired. Click OK. 

Importing Contacts 

You can populate the Bria contact list by importing from an external file or files. Your system 
administrator may have placed a file on a server for you to import. You can also import your own file or 
files, as many as required. The new contacts will be added to the existing contacts.  

You can import a contact list from: 

•  A comma-separated file. Use this method to import from a Microsoft® Excel® file. You will first have 
to set up the file; see below.  

•  A Microsoft® Outlook® or Microsoft® Exchange contact list (a *.pst file). 

•  A vCard file (*.vcf file). A vCard is an electronic business card that is often attached to an e-mail. 

1.  From the main menu, click the Contacts menu and choose Import Contacts. The Import Contacts 
wizard starts.  

2.  As soon as you click Finish on the wizard, the Contacts tab in Bria is updated to show the imported 
entries. 

Setting up an Excel File for Import 

1.  Remove any introductory text or headings from the top of the file. (You can keep text at the end of 
the file; it will be ignored during the import.) 
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2.  Insert a blank row as the first row, then insert the headings that Bria will use to interpret the 
meaning of each column. The columns can be in any order. The most popular headings are: 

•  display-name 

•  entry_id  

•  given_name  

•  surname  

•  postal_address. 

For a complete list of headings, see “Contact List Headings”. 

3.  Save the file as *.csv. 

External Storage of the Contact List 

Each time Bria is started, the contact list is retrieved from the external storage. Each time a contact is 
added to the contact list, it is immediately copied to external storage.  

The list is always stored on the local computer. In addition, if you have access to a remote storage 
server, you can configure Bria so that the contact list is also stored remotely using XCap or WebDAV. 

Exporting Contacts 

You can export a contact list to a comma-separated file, a pst file or a vcf file. 

1.  From the main menu, click the Contacts menu and choose Export Contacts. The Export Contacts 
wizard starts.  

2.  When you click Next, the export starts. The result is: 

•  For an Outlook export, the existing .pst file is updated to include the entries from the Bria 
contact list. If Outlook is open, the entries immediately appear in the contact list.  

All information in the Bria contact list is exported to Microsoft Outlook. Only information that 
can be displayed in Outlook actually appears in the Outlook Contacts window. Typically this 
means that all softphone addresses are exported (and stored in custom fields) but not displayed 
in Outlook. 

•  For other formats, a new file of the specified type is created. 

Managing Contacts 

Changing Contact Information 

To change the information for a contact, right-click the contact and choose View Profile. The Contact 
Profile dialog box appears. Some of the changes you can make are: 

•  Change any contact details. 

•  Add, delete or change a contact method. 

•  Move a contact to another group by selecting a different group. 

•  Add an existing contact to more groups by selecting one or more extra groups. 

Moving or Deleting a Contact 

•  To drag one or more contacts to a different group, select them and drag to the new group. 

•  To delete one or more contacts, select them, right-click, and choose Delete. The contacts are 
removed from this group. 
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Adding, Deleting or Renaming Groups 

Select any group, right-click, and choose the appropriate menu item. 

Contacts that have no group appear under “Ungrouped Contacts.” You can delete, but not rename, this 
group. 

Using Contacts 

Phone the person •  Double-click the contact to start a phone call. 

•  Drag the contact to the call display to start a phone call. 

Phone the person Right-click and choose Call, then click the desired number. 

E-mail a contact who has an  
e-mail address 

Right-click and choose Send E-mail. 

 

Contact Flyout 

Left-click on a contact to show the Contact flyout. This flyout shows all the contact methods set up for 
the contact and has icons you can click to perform an action that is valid for that contact method. 

 

Finding a Contact 

If the contact list is long, use the  field to filter the contacts that are displayed. To clear the filter 

and display all contacts again, click . 

Click an icon to 
perform the action 
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History Tab 

 

Managing the Lists of Calls 

You can right-click on an entry in a list to: 

•  Delete the call. 

•  Delete all entries in this list. 

•  Block this person to control whether they can send you phone calls. You can change these privacy 
settings at any time. 

•  View their profile if the entry is a contact. 

•  Add to contacts. Select Add as Contact to display the Add a Contact dialog box. Complete the dialog 
box and click OK. 

Phoning from a List 

You can right-click on an entry in the Received or Dialed list to: 

•  Place a call to this person, using the contact method that was used for this call. You can also 
double-click to place a call. 

•  Place a call to this person and add them to a conference call that is in progress. For more 
information on conference calls, see “Conference Calls”. 

 

  

Incoming call that was 
answered 

Display all calls 

Missed calls 

Received calls 

Dialed calls 

Outgoing call. If 
answered, status shows 

duration. If not answered, 
status shows “dialed” 

Incoming missed (Missed) 
or blocked (Rejected) 
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Privacy 

You can set up controls in advance or “on the fly” (as phone calls come in). 

Setting up Controls “on the Fly” 

On an Incoming Call 

To block someone when they are phoning you, choose Options > Block this Person.  

 

The call is declined, and this person is added to your Blocked List. In addition, if the person is a contact, 
then “blocked” appears beside their name in the contact list.  

You will no longer see incoming calls or instant messages from this person; they will automatically be 
declined.  

To later unblock this person, remove them from your Blocked List. Or, if the person is a contact, 
right-click their name on the contact list and choose Unblock this Person. 

From the Contact List or History List 

Right-click on the name and choose Block this Person. The person will be added to your Blocked List. The 
person will not be able to phone you.  

To later unblock this person, right-click on the name and choose Unblock this Person. 
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Configuring Bria 

You can configure Bria in several ways: 

•  Configure global behavior. 

•  Configure the behavior on a per-account basis. 

Configuring Preferences 

Choose File > Preferences. The Preferences window appears.  

The Preferences panels let you control the way that you work with Bria.  

Preferences – Application 

 

This panel lets you set your preferences for general GUI behavior.  



Cypress Communications  

28 

Preferences – Alerts & Sounds 

 

This panel lets you control the Call Alerts box and lets you assign sounds.  

Enable alert displays 

You can control whether the Call Alert box is displayed for incoming calls. 

 

Assigning Sounds 

You can assign specific sounds to a variety of actions or “events”. 

1.  Select the Enable sounds check box and select the check boxes for each desired event, or clear the 
Enable sounds check box to disable all sounds. 

2.  If enabling sounds, you can change the sound for each event: select the individual event. The value 
in Sound preference will change. Select the desired sound. 
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Keep in mind that you can also override any sound for an individual Contact.  

You can import sounds; these will be added to the list of sounds you can choose from when assigning a 
sound to an event. 

 

 

Preferences – Quick Transfer 

 

This panel lets you set up a list of phone numbers that calls can be transferred to. Then during a call, you 
can transfer to any of these numbers by selecting from a list. 

Enter as many numbers as you want. To enter a new number, click in an empty line. To remove an entry, 
click in the line and delete the number. Set one of the numbers as the default. 
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Preferences – Devices 

 

Bria automatically detects devices at each startup, and selects the most appropriate device for each 
purpose. If you do not like this selection, you can override it on this panel. 

If you override a selection, it will apply the next time you start Bria, unless the device is no longer 
available, in which case Bria will again select the device to use. 

Field Description 

Headset Mode 

Speaker 

Microphone 

Change these fields only if you want to override the devices that Bria automatically 
selected. 

In both these fields, select the headset you are using. 

The headset is the device that is usually used for audio out (the sound you hear) and 
audio in (recording your voice). The only situation in which the headset is not used is 
when the Speaker Phone button on the dialpad is pressed.  

Therefore, unless you will always be using Bria in speakerphone mode, you must make 
a selection here. 

Select the headset in both the Speaker device field and Microphone device field. 
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Speakerphone Mode 

Speaker Change this field only if you want to override the devices that Bria automatically 
selected. 

Make the appropriate choice: 

•  Select the device that you want to use for audio out (the sound you hear) when the 
Speaker Phone button is pressed. Make sure you select a speaker device (not the 
headset). 

•  Select None if you do not have a speaker phone. The Speaker Phone button on the 
dialpad is disabled. 

Microphone Change this field only if you want to override the devices that Bria automatically 
selected. 

Make the appropriate choice: 

•  Select the device that you want to use for audio in (recording your voice) when the 
Speaker Phone button is pressed.  

It can be any microphone: it does not have to be the microphone on the device you 
specified as the speaker device. For example, it can be the microphone on your 
camera.  

•  Select None if you do not have a speaker phone. The Speaker Phone button on the 
dialpad is disabled. 

Reduce background 
noise 

Automatically attempts to remove background noise. 

Typically on for the speakerphone. 

Phone Ring Device 

Device Change this field only if you want to override the devices that Bria automatically 
selected. 

The device where you want to hear the phone ringing: the headset, the speakerphone, 
or none. 

Volume The volume of the ringer. 

Also ring PC speaker Click on or off, to suit your preference. 
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Preferences – Network 

 

 

Field Description 

Network Connection Speed Select the type of network connection for your computer. 

The sliders move to show the bitrate that will be used for sending and receiving. 
These rates are typical rates for the selected configuration. 

If you know that your computer and network can handle a faster sending speed, click 
Custom and move the slider. 

It is recommended that you not change the receiving speed. 

You will know that you have set the sending speed too high if: 

•  The remote audio is garbled. 

Preserve bandwidth When this feature is on, Bria stops sending audio when you are not talking. 

When this feature is off, Bria always sends audio, which uses more bandwidth but 
may result in better call quality. 

Typically off. However, if you are using a slow (dial-up or ISDN) connection, you may 
want to turn it on. 
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Preferences – Audio Codecs 

 

This panel shows all the codecs that are included in this version of Bria. You can enable or disable codecs 
as desired.  

With only one codec enabled, all calls made will use that codec. With more than one codec enabled, Bria 
automatically chooses the best codec based on the other party’s capability, the available bandwidth, 
and network conditions. 

You cannot change the properties of any codecs. 

About Codecs 

Audio codecs describe the format by which audio streams are compressed for transmission over 
networks. Codecs can be categorized as either narrowband or wideband: 

•  Narrowband codecs work with low bandwidth such as a dialup internet connection. These codecs 
have a sampling rate of 8 kHz. 

•  Wideband codecs work with high bandwidths and result in better audio quality. However, they do 
not work with PSTN. These codecs have a sampling rate of 16 kHz. 

Supported Codecs 

Bria supports a wide range of codecs. See the table. 
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Codec Narrowband Wideband Royalty-bearing 
Included in 

Bria 

Broadvoice-32    

Broadvoice-32 FEC    

DVI4    

DVI4 Wideband    

G.711aLaw *    

G.711uLaw *    

G.729 *    

GSM    

iLBC    

L16 PCM Wideband    

Speex    

Speex FEC    

Speex Wideband    

Speex Wideband FEC    

* Generally, at least one of these codecs must be enabled in order to place a PSTN (land line) call.  
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Preferences – Quality of Service 

 

The Quality of Service panel lets you request a specific transport service for audio and signaling traffic. 

There is one type of service. Support of this service depends on your internet service provider: 

•  DSCP (also known as ToS), which is available for audio, video and signaling. 

In a network that has the default configuration, the recommended value for audio is 46, because 
“46” is the standard marking for audio. 

Bria supports 802.1p QoS packet tagging. If you set up for QoS, Bria will include the specified 
information in the packets that it sends to the network provider. Whether the packet is delivered with 
the specified service depends on whether your broadband router and the network provider between 
you and the other party supports multiple transport services. In other words, whether each network 
provider reads the QoS information and prioritizes packet delivery based on the requested service.  
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Preferences – Contact Storage 

 

These settings let you set up a remote storage system for your contact list via WebDAV or XCAP. (The 
contact list is always stored locally, even when you set up for remote storage.)  

The contact list holds general information for contacts. It is automatically loaded at startup, and is 
loaded even if no accounts are enabled. 

Table 3: SIP Account Properties – Storage 

Field Description 

Storage method The storage method to be used for the Contact list file. The file can be stored locally 
or both locally and on a remote computer. 

Server Settings 

Use SIP credentials Check this box to use the username and password from your SIP account in order to 
log into the storage server. 

Otherwise, uncheck this box and complete the Username and Password fields. 

Not used for “Local”. 

Root URL URL of an appropriate root folder on the remote server. 

Not used for “Local”. The factory setting is 
https://webdav.$domain$/webdav/$username$/ 
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WebDAV poll time Enabled only for WebDAV. The time that elapses between polling for new contact 
data from the remote server. 

The factory setting is 600. 

 

Preferences – Diagnostics 

 

This panel lets you enable logging to files. Logging uses computer resources, so you should only enable it 
when instructed by a customer support representative. 

To set up logging: 

1.  Click Enable diagnostic logging.  

2.  Set the logging level.  

3.  Specify the folder where logs will be saved. 

4.  Click OK. 

Activity on Bria will be logged to.csv files in the specified folder. A new set of files is started each time 
you log on. In order not to create large files when logging (which may create computer problems), you 
must not remain logged on indefinitely when logging. You should occasionally exit and restart Bria. 
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If requested by a customer support representative, you can: 

•  Open the logging folder and then open a log file using a text editor.  

•  E-mail the logs in the specified folder to customer support: Click Send logs to customer support. A 
dialog box appears showing all the logs. Select files and click Open; the selected files are sent and 
the dialog box closes. 

You can delete log files from the specified folder as you would delete any file on your computer. 

Preferences – Advanced 

 

 

Field Description 

Reduce echoes Turning this feature on improves sound quality. This feature is typically 
on. 

Auto Answer Calls 

Auto answer incoming calls From the first set of radio buttons, choose how quickly you want Bria 
to auto-answer an incoming call. 
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Configuring Accounts 

Choose File > Account Settings. The Account Settings window appears.  

Accounts Settings Window 

To work with accounts, choose File > Account Settings from the menu. The Account Settings window 
appears, showing all the accounts set up.  

 

You can: 

•  Add or remove an account.  

•  Enable one or more accounts. See below for details. 

•  Set one account as the default. See below for details. 

•  Set or change the properties of an account. These properties control how Bria interacts with your 
VoIP service provider, and are set individually for each account. Click the Properties button, then 
see the following pages for details.  

Enabling Accounts 

You must enable an account in order to make and receive calls on that account. You can enable as many 
accounts as you want. Click the Enable box beside each account. The rules for enabled accounts are: 

•  When multiple accounts are enabled, you will be able to receive calls on all those accounts. 

•  You can never place a call on a disabled account. If you place a call that is only valid on the disabled 
account, it will fail with a “Not found” message. 

•  You can never receive a call on a disabled account. If another party phones you on a number that is 
only known to a disabled account, the call will never appear on your Bria.  

•  When multiple accounts are enabled, the account to use for an outgoing call is determined by the 
rules of the dial plan determine which account is used. If you have not set up any dial plans, then the 
default account is used.  
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Setting the Default Account 

When multiple SIP accounts are enabled, the first account listed is always the default. Use the Move Up 
and Move Down buttons to set the desired account as the default.  

The dial plan rules may select the default SIP account in order to place an outgoing call. 

 

SIP Account Properties – Account 

 

Table 5: SIP Account Properties – Account 

Field Description 

Account name If desired, change the account name to something that is meaningful to you. For 
example, the name of the VoIP service provider. 

Protocol Read-only. Always specifies SIP. 

User Details 

User ID Typically the account number for the softphone account plus the domain. For 
example, kpereira@domainA.com. Provided by Cypress Communications. 
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Password Provided by Cypress Communications. 

Display name This name is displayed in the Bria display. 

Other parties will see this name when they are connected to you. 

Authorization name May not be required. If it is required, it will be provided by Cypress 
Communications. 

Domain Proxy 

Register with domain and 
receive calls 

Check this box if you want to register with Cypress Communications, so that you 
can receive incoming calls. 

Typically, this field is checked.  

This field may be left unchecked when, for example, your level of service does not 
include the ability to receive incoming calls. In that case, turning this field on may 
cause registration to fail (when you close the Account Properties window), 
meaning that your Bria cannot register with Cypress Communications. 

Send outbound via Choose the setting specified by Cypress Communications:  

•  Domain: If Cypress Communications requires that traffic be directed to proxies 
that are discovered via the domain. 

•  Proxy Address: If Cypress Communications has an outbound proxy address and 
requires that you provide the address to Bria. For the address enter a domain 
name (for example, domain.com) or an IP address (for example, 
123.456.789.012).  

Dial Plan Information about the syntax of the numbers used by Cypress Communications.  

Provided by the service provider. The default plan is: 

#1\a\a.T;match=1;prestrip=2; 

It is possible that this plan will work for you. If you can place a successful call, then 
the dial plan is suitable. If you cannot make a call, or if you want to set up a dial 
plan for your own reasons, see “Dial Plan”.  
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SIP Account Properties – Voicemail 

 

These settings let you set up Bria to forward calls in several situations. 

Your service provider may also provide the ability to set up for voicemail outside of Bria, for example, by 
phoning a softphone address and following the voice prompts, or by accessing a website.  

Check with your service provider to determine if another setup mechanism is available. If so, check what 
the settings are in that setup, and make sure you do enter compatible information in Bria.  
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Table 6: SIP Account Properties – Voicemail 

Field Description 

Check for voicemail If your VoIP service includes voicemail, choose the setting specified by your 
VoIP service provider.: 

•  On: Bria will subscribe to be notified when there is a voicemail for you.  

•  Off: the service provider may be set up to advise Bria when there is a 
voicemail for you; check with your service provider for details. 

If your VoIP service does not include voicemail, choose Off.  

Voicemail is controlled by your VoIP service provider, not by Bria. Contact 
your service provider for information on using voicemail. 

Number to dial for checking 
voicemail 

Complete only if your VoIP service includes voicemail. 

This is the number that will be called when you click the  icon on the call 
display, in order to connect to voicemail and listen to your messages.  

If you leave this field empty, then this icon will not work; you will have to 
manually dial this number in order to connect to voicemail. 

Enter the number provided by your VoIP service provider. 

Number for sending calls to 
voicemail 

Complete only if your VoIP service includes voicemail. 

This is the number that incoming calls will be forwarded to if they are 

unanswered after the specified interval (below), or when you click the  
icon on the call display. 

If you leave this field empty, then this icon will not be displayed. However, 
leaving this field does not mean that voicemail does not work. It only means 
that this icon cannot be used to send to voicemail immediately. 

Enter the number provided by your VoIP service provider. 

Send calls to voicemail if 
unanswered 

Complete only if your VoIP service includes voicemail. 

To send to voicemail after the specified number of seconds.  

Your service provider may also provide a similar feature that is set up outside 
of Bria. If so, make sure you do not enter competing information in Bria and 
in the service provider’s user interface. For example, if you turn off this field, 
make sure the same feature at your service provider is also turned off. 
Otherwise, all your calls will continue to be forwarded. 

Always forward to this address You can use this feature even if your VoIP service does not include voicemail. 

To always forward phone calls, click the box and enter the address to 
forward to. Phone calls received on other accounts (if you have them) are 
not affected by enabling this field.  

Forward to this address when busy You can use this feature even if your VoIP service does not include voicemail. 

To forward only when you are on another phone call, click the box and enter 
the address to forward to. Phone calls received on other accounts (if you 
have them) are not affected by enabling this field.  

Your service provider may provide a similar feature that is set up outside of 
Bria. If so, make sure you do not enter competing information in Bria and in 
the service provider’s user interface. For example, if you turn off this field, 
make sure the same feature at your service provider is also turned off. 
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SIP Account Properties – Topology 

 

Table 7: SIP Account Properties – Topology 

Field Description 

Firewall Traversal 

IP Address This setting controls how your IP address is presented.  

•  Discover global address: Let Bria determine your public IP address. This is the recommended 
setting unless your VoIP service provider advises otherwise. 

•  Use local IP address: use the IP address of the Bria computer. 

The recommended setting is Discover global address. 

STUN Server This setting specifies the STUN server to use. 

•  Discover the server: Choose this option to let Bria find the address of a STUN server.  

•  Use this server: To use a different STUN server. For the address enter a domain name or an 
IP address.  

The recommended setting is Discover server. 
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Enable ICE ICE optimizes traffic and may help with firewall traversal. 

Typically, ICE is enabled. However, it may need to be disabled if your VoIP service provider has 
implemented a firewall traversal solution that is not compatible with ICE enabled.  

If you have problems with calls, contact your VoIP service provider for information on their 
firewall traversal solution. 

Range of Ports on Local Computer 

Range of ports 
used on local 
computer 

The appropriate setting depends on your computer setup: 

•  Checked: If your computer is behind a restrictive firewall that only allows specific port 
ranges to be used. Enter the range of ports to use for your SIP account. (You must also open 
those ports on your firewall; refer to applicable firewall documentation for information.) 

•  Unchecked: If your computer is not behind a restrictive firewall.  
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SIP Account Properties – Security 

 

 

Table 10: SIP Account Properties – Security 

Field Description 

Signaling Transport Contact your VoIP service provider to identify the types of transport that are 
supported. Then choose a supported transport: 

•  Automatic: Bria sets up the transport based on the capabilities of the network 
and the Bria computer. Choose this option if you do not care which transport 
is used. 

•  TCP: This transport provides no signaling security.  

•  UDP: This transport provides no signaling security.  

•  TLS: Choose this option to request signaling encryption. 
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SIP Account Properties – Advanced 

 

Table 12: SIP Account Properties – Advanced 

Field Description 

Register Settings 

Reregister every The time interval between Bria’s attempts to reregister in order to refresh the 
account registration with the VoIP service provider for this account. A value of zero 
means not to reregister after the initial registration. 

This value is placed in the “Expires” header field of the REGISTER message. 

The factory setting is 3600. 
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Minimum time If the reregistration fails, Bria will wait this amount of time, then attempt to 
reregister. If the second attempt fails, Bria will wait twice this time and try again, then 
four times this time, and so on, until reregistration succeeds. 

The factory setting is 20. 

Maximum time This is the maximum wait time between attempts to reregister. Once this maximum is 
reached, Bria will wait this time for all subsequent attempts. 

For example, the min. time is 20 secs, the maximum time is 120 secs. Bria will attempt 
to reregister as follows: 

•  Wait 20 secs. 

•  Attempt to connect.  

•  If fail, wait 40 secs. 

•  Attempt to connect. 

•  If fail, wait 80 secs. 

•  Attempt to connect. 

•  If fail, wait 120 secs (the maximum) 

•  Attempt to connect. 

•  If fail, wait 120 secs, and so on. 

The factory setting is 1800. 

Timers 

Enable session timers 

Default session time 

A session timer is a mechanism to detect whether a call session is still active from the 
signaling point of view. When the timer expires, a refresh is sent from one party to 
the other. The timer is then reset. 

•  Turn on to enable session timer. Enter a value in Default session time. The factory 
setting is 60. 

•  Turn off to disable session timer; refreshes will never be sent. 

Session timer preference This field specifies your preference for which party should send the refresh. The 
preference is not a guarantee that the refresh will be performed by the specified 
party. The choices are: 

•  None: No preference. 

•  Local refreshes: Your computer sends. 

•  Remote refreshes: The other party sends. 

•  UAC refreshes: The user agent client (the party that initiated establishment of the 
communications) sends. 

•  UAS refreshes: The user agent server (the other party) sends. 

Send SIP keepalives Typically on, to instruct Bria to send SIP keepalive messages in order to maintain a 
“pinhole” through your firewall for SIP messaging. 

Use rport Typically on. 

Send outgoing request 
directly to target  

When checked, requests with a complete URI (user@ABC.com) go to ABC.com and 
the “Send outbound via” field on the Account tab is ignored. 

Typically off. This field is intended for test labs and may cause problems in a NAT 
environment. 
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Appendix 

Application Hot Keys 

Function Keyboard Shortcut 

Answer Enter 

Exit Ctrl+Q 

Hang up Esc 

Hold Period 

Mute Spacebar 
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Dial Plan 

When a call attempt is made, the call input (what you type, select or drag onto the call entry field) is 
compared to the dial plans that exist in order to select the SIP account to use and in order to determine 
if the input must be modified to ensure that the call can succeed. Each dial plan contains one or more 
patterns; if the input matches a particular pattern, then the input is modified according to the rules for 
that pattern, and then the call is placed using the account that the dial plan belongs to.  

Determining whether You Need a Dial Plan 

If you are an independent user of Bria, you may need to modify the default dialing plan. 

If you are deploying Bria in an enterprise, you will typically need to modify the default dialing plan. 

1.  Check with your VoIP service provider for any dialing plan information. If you service provider has a 
dialing plan, use it. If you have several SIP accounts, each with a different service provider, obtain 
the dialing plan for each account. Enter the dialing plan in the account information. 

2.  If no ready-made dialing plan is available for an account, enable only that account and make 
different types of phone calls: 

•  Calls to another SIP address (rather than to the PSTN). 

•  Local calls to the PSTN (if your VoIP service provider supports these calls) 

•  Long-distance calls to the PSTN (if your VoIP service provider supports these calls). 

Try placing calls by typing in the entry field and also by selecting a contact. 

3.  If all types of calls succeed, the default dialing plan does not need to be modified for that account. 

If at least one type of call fails, you must modify the default dialing plan for that account.  

 
The Default Dial Plan 

The default dial plan is: 

#n\a\a.T;match=1;prestrip=2; 

where #n is the account prefix (#1 for the first account in the list (proxy0), #2 for the second account 
(proxy1), and so on). 

If the input is the account prefix and the number, then the Account for this dial plan is selected. The 
account prefixed is stripped from the number before the call is placed. 

If all Accounts use this dial plan, then the behavior is as follows: if the input includes the account, then 
that account is used. In other words, you can force selection of a specific account by including the 
account prefix. If the input does not include #n, then the default account is used. 

How Dialing Plans Are Used 

When you place a phone call, Bria takes the phone number (the input) and performs the following: 

Cleanup 

This step is not part of the dialing plan: it is always performed even when there is no dialing plan. 
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Input is cleaned up by removing spaces, dashes, open brackets, and close brackets.  

Matching 

The input is compared to the patterns defined by the dial plan for each enabled account. Each account 
has one dial plan, and each dial plan has one or more patterns. 

When a match is found between the input and the pattern, the account that this pattern belongs to is 
selected and the transformation for this pattern is performed. 

If no match is found, the default account is selected and no transformation is performed. 

Transformation 

The selected transformation is performed. 

Place Call 

Then the call is placed using the transformed input.  

Dial Plan Syntax 

In Bria, the dial plan establishes the expected patterns of characters for a telephone number or 
softphone address, and allows for modification (transformation) of input based on the match to a 
pattern. The dial plan has the following syntax: 

pattern[|pattern];match=1;<transformation>=<value>;[match=2; 

<transformation>=<value>;] 

Where: 

•  Items in [ ] are optional.  

•  Pattern: the pattern that will be matched. One or more patterns. Each pattern is separated by a | 
pipe. The pipe is optional after the last pattern. Each pattern is implicitly numbered, starting from 1. 

•  Match; Transformation: A pair that identifies the pattern number to compare with the input, and 
the transformation to perform on the input when a match is obtained. The transformation is 
optional (meaning that if there is no transformation for a pattern, then the input that matches this 
pattern is not transformed). One or more pairs. 

“match=” is a literal. “n” identifies the pattern. “transformation=” is replaced by a keyword, see 
below. “value” is replaced by a value. 

Spaces are allowed only in the <value> items.  

Remember that dial plans are applied after the input has been cleaned up! 

 

Example 

\a\a.T|xxxxxxxxxx;match=1;prestrip=2;match=2;pre=8; 

where: 

•  \a\a.T   is the first pattern. 

•  xxxxxxxxxx;   is the second pattern. 

•  match=1;prestrip=2; is the first match-transformation pair. 
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•  match=2;pre=8;  is the second match-transformation pair. 

Pattern 

Valid Content 

The content for a pattern follows the digit map rules of RFC 2705, supplemented by the rules for regular 
expressions. Where there is an overlap between the digit map and regular expression rules, the digit 
map rules apply. For this reason, there are some special cases, included in the table below. 

The following table describes the most common elements. As mentioned, all regular expression 
elements are supported. 

Element Origin Description 

0 1 2 3 4 5 6 7 8 
9  

Literals Literal digits, used as is.  

# * a to z Literals Literal characters, used as is. Special cases:  

•  The literal x character is represented by \x. 

•  The literal t character is represented by \t. 

x Digit map rules Wildcard for any single digit, 0 to 9.  

\a Regular 
expression rules 

Wildcard for any single alphanumeric character. 

[digit-digit] Regular 
expression rules 

A digit within the specified range. 

[character-chara
cter] 

Regular 
expression rules 

A character within the specified range. 

[digit1, digit2, 
digit3] 

Regular 
expression rules 

One of the characters in the collection. 

. Digit map rules Repeat the last element 0 or more times. For example, xxxx. means repeat the 
last x 0 or more times, which means this pattern matches three or more digits 
(not four or more digits)! Use of this element results in a pattern with 
“minimum requirements”.  

T Digit map rules A timeout period will take place before automatic dialing starts. 

The T timer forces Bria to wait after a match is made. This timer should always 
be included in these situations: 

•  Any pattern that uses the . (dot). For example, if the pattern is xxxx. then 
adding a timer lets you type three or more digits. If there is no timer, then 
as soon as you type three digits, Bria makes the match as soon as you type 
three digits.  

•  Any dial plan that has two patterns that are similar in elements but 
different in length. For example, if one pattern is xxx and the other pattern 
is xxxxxxx, then adding the timer lets you continue typing past three digits, 
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in order to get a match on the second pattern. 

 In this situation, the T timer should be included in the shorter pattern.  

 

Timers 

There are two timers, the T timer and the long timer. These timers are used in input comparison, as 
described in. 

Transformation Keywords 

Keyword Description 

prestrip Strip the first n characters from the input 
before placing the call. 

poststrip Remove n number of characters from the 
end of the input before placing the call. 

pre Add the specified account prefix to the 
input before placing the call. 

post Attach the specified postfix to the input 
before placing the call. 

replace Replaces the input with the specified 
string before placing the call. 

 

Order of Transformations 

These transformations are always performed in the following order (the order in which the 
transformations are entered in the dial plan is not significant): 

prestrip  >  poststrip  >  pre >  post  >  replace 

How the Input Is Processed 

Comparing Input to the Dial Plan Patterns 

The input is compared to each dial plan in turn, starting with the first listed account. The process is 
slightly different depending on how the call is placed: 
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•  If the input was dragged or selected, then the entire input is compared to each dial plan. If a 
complete match is found, then that account is selected and the associated transformation is 
performed. If no match is found, the default account is selected and no transformation is 
performed.  

•  If you are typing the input, the digits are compared one by one as they are entered. The comparison 
will result in one of the types of matches described in the table below. 

It is possible for the same input to get matched to different dial plans depending on whether the input is 
entered on the fly or dragged. It is important to keep this in mind when designing dial plan patterns.  

Results of the Comparison 

Bria finds a match according to the following rules. These rules work on three elements: 

•  The patterns specified in the dial plan. 

•  The T timer, if it is included in the pattern.This timer is a short (critical) timer. T timer is 4 seconds. 

•  The long timer, which is always effective (it does not have to be included in the pattern). The long 
timer is 20 seconds. 

Type of Match Conditions 
Result if You Press 

Enter or Dial 
Result if You Stop Typing 

Partial match  The characters typed so far follow the 
pattern but there are not yet enough 
characters for a pending or complete 
match. 

The default account is 
selected. No 
transformation is 
performed. 

 

If you stop typing for the 
long timer length (20 
seconds), then the default 
account is selected. No 
transformation is 
performed on the 
characters typed so far. 

Pending match •  The pattern has no . (dot) but does have 
the T timer. There is a perfect match. 

•  The pattern has a . (dot) and the T timer. 
The minimum requirements are met. 

This pattern's account is 
selected and the 
transformation is 
performed. 

 

If the T timer expires, this 
pattern's account is 
selected and the 
transformation is 
performed. 

Complete 
match 

•  The pattern has no . (dot) and no T 
timer. There is a perfect match. 

•  The pattern has a . (dot) but does not 
have the T timer. The minimum 
requirements are met. 

This pattern's account is 
selected and the 
associated 
transformation is 
performed. 

This pattern's account is 
selected and the 
associated transformation 
is performed. 

No match The characters typed do not match the 
patterns for any dial plan. 

The default account is 
selected and no 
transformation is 
performed. 

Nothing happens even 
after the T timer and long 
timer have expired. 

 

Examples 

Example 1 

\a\a.T|xxxxxxx.T;match=2;pre="9" 
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This simple example shows how to differentiate between a PSTN number and a softphone address, and 
how to add a “9” dialing prefix only to the PSTN number.  

Example 2 

3xxT|1xxxxxxxxxx|[2-9]xxxxxxxxx|+x.T;match=2;pre="9"; 

match=3;pre="91";match=4;prestrip=1;pre="9011" 

3xxT The first pattern is any three-digit number beginning with 3. No transformation. 
The assumption is that this is an internal extension. The timer forces Bria to wait 
after detecting a three-digit number beginning with 3, in case you are actually 
dialing a local call starting with 3.  

1xxxxxxxxxx The second pattern is any eleven-digit number beginning with 1. Prefix with 9 and 
dial as is. The assumption is that this is a long-distance PSTN call within North 
America (within North America, all long-distance calls start with 1). 

[2-9]xxxxxxxxx The third pattern is any ten-digit number beginning with a number other than 1. 
The assumption is that this is a local PSTN call within a ten-digit dialing zone.  

+x.T; The fourth pattern is a number of any length that begins with +, to indicate an 
international PSTN call from North America. Delete the +, prefix with 9011 (011 is 
the number to access an international line from North America). 

match=2;pre="9"; For the second pattern, prefix 9 to access an outside line. 

match=3;pre="91"; For the third pattern, prefix 9 and 1 to access an outside line and enter the 
long-distance code. 

match=4;prestrip=1;pre="901
1" 

For the fourth pattern, remove the + and prefix 9011 to access an outside line and 
enter the international code. 

 

Example 3 

#1xxxxxxxT|#19xxxxxxx|xxxxxxxT|9xxxxxxx|;match=1;prestrip=2;pre=9;match=2;

prestrip=2;match=3;pre=9; 

#1xxxxxxxT The pattern is an account prefix followed by seven digits. The timer forces Bria to 
wait to allow a match to the second pattern. The #1 is stripped off and 9 is 
prepended to access an outside line. 

#19xxxxxxx The pattern is an account prefix followed by a 9 and seven digits. The #1 is 
stripped off. 

xxxxxxxT The pattern is seven digits. The timer forces Bria to wait to allow matching to the 
fourth pattern. 9 is prepended to access an outside line. 

9xxxxxxx The pattern is a 9 and seven digits. The input is not transformed. 

 

This example assumes that the dial plan belongs to the first account.  
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The dial plan is slightly trivial, because it does not cover all the situations that a dial plan should be 
designed for (local calls, long-distance calls, international calls, and so on for the locale).  

However, the example does illustrate two ideas: 

•  Handling of the account prefix (#1), if you are upgrading from Bria 1.1 and are accustomed to 
entering the account number.  

Use of # to identify the account is now deprecated. The dial plan should be capable of determining 
the account to use for this number. However, since users may still be in the habit of entering the 
account prefix, you may want to include this pattern to handle such a scenario. 

•  Distinguishing between a local seven-digit call in which 9 is not dialed (to access an outside line) and 
one in which 9 is dialed to access an outside line.  

Contact List Headings 

Following is a list of all the headings that are used in the Bria contact list. This list can be useful when 
formatting a contact list in order to import it into Bria. 

uri  business_number sms_address s 

display-name business_number2 ms_address2  

entry_id  business_number3  sms_address3  

given_name  business_number4  sms_address4  

surname  business_number5  sms_address5  

email_address  business_number6  sms_address6 

email_address2 mobile_number  custom_fields  

email_address3  mobile_number2  custom_fields2  

email_address4  mobile_number3  custom_fields3  

email_address5  mobile_number4  custom_fields4  

email_address6  mobile_number5  pres_subscription 

sip_address  mobile_number6   

sip_address2  fax_number   

sip_address3  fax_number2   

sip_address4 fax_number3   

sip_address5 fax_number4   
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sip_address6  fax_number5   

home_number fax_number6   

home_number2  groups   

home_number3  comment   

home_number4 postal_address  

home_number5 default_address   

home_number6 default_address_type  
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Location of Files 

System files get copied to the installation directory specified when installing Bria. The default installation 
directory is: 

C:\Program Files\Cypress Communications\Bria\ 

 

Other Ways to Run Bria  

From a Hyperlink 

You can attach a hyperlink to a phone number or softphone address that, when clicked, starts Bria and 
dials the number. Attach a hyperlink with this format: 

<a href="sip:<address or number>">dial <address or number></a> 

For example: 

<a href="sip:kpereira@domainA.com">dial kpereira@domainA.com</a> 

From the Command Line 

You can start Bria from a DOS prompt. You may need to add Bria.exe to the PATH. Then type: 

Bria.exe 

To start Bria from a DOS prompt and immediately dial a number, type: 

Bria.exe -dial=sip:<number> 

Glossary 

 

AEC Acoustic echo cancellation. Processing of the audio or video signal to reduce the 
echo effect that can arise with a speakerphone or that can arise if the sound 
from the speakerphone or headphone leaks into the microphone.  

AGC Automatic gain control. Processing of the audio or video signal to adjust the 
microphone volume level so that the other party does not hear the distortion 
that might be caused by too high a microphone input or too low volume (due to 
too low input level). 

AVI Audio Video Interleave. A multimedia container format. AVI files contain both 
audio and video data in a standard container that allows simultaneous playback. 

Broadband Broad or wide bandwidth. In data transmission, the wider the band, the more 
data it is possible to transmit in a given time span. A cable, DSL and ADSL 
connection to the network provide broadband for data transmission. A dialup or 
ISDN connection typically provide a narrow bandwidth for data transmission. 

Codec The format by which audio or video streams are compressed for transmission 
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over networks. 

Default account The SIP account that will be used when placing an outgoing call, if Bria does not 
determine that another account should be used. Bria uses the dial plan to 
determine the account to use.  You can mark one account as the default 
account; see “Setting the Default Account”. 

Dial plan The rules that Bria follows in order to interpret the softphone address or phone 
number that the user has entered and to modify the number or address, as 
required, to ensure that the call will be placed successfully.  

DTMF Dual-tone multi frequency. DTMF is the system that is used in interactive 
voice-response menu systems such as the menu system for accessing voicemail 
messages. The DTMF system allows the user to interact with the menu by 
pressing keys on a dialpad or keyboard. 

IM Instant Messaging. A technology that lets users send text message and files for 
near instantaneous delivery and display on each others’ computers. 

IP Internet Protocol. A data-oriented protocol used for communicating data across 
a network. IP is the most common protocol used on the internet. 

IP address A unique number that devices use in order to identify and communicate with 
each other on a computer network using the IP standard.  

Media In a VoIP phone call, the audio and video portion of the information in a call. 
Compare to “Signaling”. 

MWI Message Waiting Indicator. An indicator that there is a voicemail message for 
the owner of an account. 

Narrowband In data transmission, the wider the band, the more data it is possible to transmit 
in a given time span. A cable, DSL and ADSL connection to the network provide 
broadband for data transmission. A dialup or ISDN connection typically provide 
a narrow bandwidth for data transmission. 

Presence An instant messaging feature that allows users to share information about their 
availability, mood, location and so on. 

Proxy See SIP account. 

PSTN Public Switch Telephone Network. The traditional land-line phone network. 

RFC Request for Comment. A document that describes an aspect of an internet 
technology. An RFC may be a proposed, draft or full internet standard. 

RTP Real-time Transport Protocol. A protocol for delivering the media portion of a 
data transmission over an IP network. SRTP is another media protocol. 

Signaling In a VoIP phone call, the information in a call that deals with establishing and 
controlling the connection, and managing the network. The non-signaling 
portion of the call is the Media. 

SIMPLE protocol Session Initiation Protocol for Instant Messaging and Presence Leveraging 
Extensions. The instant messaging (IM) protocol followed by Bria. It encapsulate 
the rules for exchanging instant messages. 

SIP Session Initiation Protocol. The signaling protocol followed by Bria for handling 
phone calls.  

SIP account An account that provides the user the ability to make VoIP phone calls. The 
account encapsulates the rules and functions the user can access. 

softphone address The address used to connect to a SIP endpoint. In other words, the “phone 
number” used in a VoIP phone call. For example, sip:joseph@domainA.com. 
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SRTP Secure Real-time Transport Protocol. A protocol for delivering the media portion 
of a data transmission over an IP network. SRTP is a secure protocol, which 
means that the media is encrypted. RTP is another media protocol. 

TCP Transmission Control Protocol. A transport protocol for delivering data over an 
IP network. Other transport protocols are TLS and UDP. 

TLS Transport Layer Security. A transport protocol for delivering data over an IP 
network. TLS is a secure transport protocol, which means that all the data being 
transmitted (signaling and media) is encrypted. Other transport protocols are 
TCP and UDP. 

UDP User Datagram Protocol. A transport protocol for delivering data over an IP 
network. Other transport protocols are TCP and TLS. 

URI Uniform Resource Identifier. A name or address that identifies a location on the 
world wide web. A softphone address is a type of URI. 

URL Uniform Resource Locator. A URI that both identifies a name or address and 
indicates how to locate it.  

USB device Universal Serial Bus device. A device that follows a specific communications 
standard. A headset may be a “USB type” of headset.  

VAD Voice Activity Detection. A technology that detects if audio is a human voice or 
background noise. Bria includes a feature (Preserve bandwidth on the Network 
panel of the Preferences window) that controls whether audio is transmitted 
when VAD determines that no one is actually speaking. 

vCard An electronic business card that is often attached to an e-mail. It often appears 
as a “signature” block that identifies the person, their title, and their business. 

VoIP Voice over Internet Protocol. A variation of IP used for sending voice data over 
the internet, in other words, used for making phone calls over the internet. 

VoIP service provider A business that provides a VoIP service, allowing a user to connect to the 
internet in order to make VoIP phone calls using Bria. The VoIP service provider 
sets up a SIP account for the user.  

WAV Or WAVE. A file format standard for storing audio on PCs. 

 


